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  Frequently Asked Questions (FAQ)Frequently Asked Questions (FAQ) 
 

 
This document contains frequently asked questions about Radar 8 for Windows and their 
answers. 
If you have a technical question about Radar and cannot find any answer in this 
document, please fill in the ‘Technical Support Form’ (icon in the Radar Start Menu) and 
send it to:  

 
Radar Hot-Line : 

 
-:   support@archibel.com 
 
Fax:   + 32 19 566 532 
 
Website: http://www.archibel.com 
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Q1. What is the Radar security key? 
Without the security key, neither Radar nor WinCHIP will run.  
There are 2 kinds of Radar security keys:  

1. Parallel model: 
it is a piece of white plastic with screws and a connector at both sides. It 
must be plugged onto the parallel printer port of the computer when working 
with Radar. Connect the security key before you switch on the computer ! 

2. USB model: 
it is a piece of green or blue plastic with a metallic connector on one end and 
a small round hole on the other end. It must be plugged on the USB port of 
the computer. 
NOTE: you must first install the Radar software before you plug the USB 
key. 

Q2. Why do I get the message “Internal Error (6)” when starting Radar ? 
The Radar security key is not attached to the computer. You need to connect it to 
the parallel printer interface or the USB port of the computer (see here above).  
On some systems, you need to change the BIOS setup of the computer and set the 
parallel port mode to “Standard” (or “SPP”) instead of “ECP” (or “EPP” or “Bi-
directional”). Please refer to the computer’s guide to learn how to enter the Bios 
setup. 
Radar needs a driver for the security key. This driver is automatically loaded during 
the installation procedure of Radar. 

Q3. How much free space on the hard disk do I need to install Radar 8 ? 
Radar program    20 Mb 
Kent Repertory    20 Mb 
Synthesis National Repertory      35 Mb 
Synthesis Repertory V7 (incl. Concepts)     35 Mb 
Repertory of Families      2 Mb 
Keynotes   ± 5 Mb 
Multimedia files  320 Mb 
WinChip program    20 Mb 
Vakil module      2 Mb 
Herscu module      6 Mb  
Vithoulkas Expert System  included in Radar program 

Q4.  How can I install a new database without re-installing the whole 
Radar? 

Run the installation procedure (A:\SETUP.EXE) from the Radar disk, choose the 
‘CUSTOM’ installation and select to install the databases only. 
Deselect all the databases that are already present on your computer and select 
the new database(s) to install : 
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 ATTENTION ! 

Do not reinstall a database that is already installed on your system because 
you will loose all your personal additions! 

  

Q5. Where do I find my license number? 
The Radar license number can be found: 

§ on the Radar Registration Card, 
§ on the Radar installation diskette, 
§ engraved on the Radar security key, 
§ on the first screen of Radar when starting the program. 
 

Q6. Why didn’t I receive a disk for the VES ? 
There is no special disk for the Vithoulkas Expert System.  
This optional module is an analysis method of the Radar program. If you have 
ordered the VES, it is part of your Radar software and is automatically installed by 
the installation procedure of the Radar program. 

You can choose the VES analysis method by selecting its icon in the toolbar :  

Q7. Which version of Radar/Synthesis do I use? 
The version of the Radar program is displayed in the title bar of the program 
window: 

  

  
  



©Archibel S.A.  QA8_ENG.doc - (9/05/2001) – Page 7  

  
The version of the Synthesis repertory is displayed in the title bar of the repertory 
window: 

  

  
  

Note that the Synthesis version can differ from the Radar version. You could for 
example use Radar 8 with the English Synthesis 6.0 or 7.0 or the French Synthesis 
5.05. 

  

Q8.  How do I create a shortcut to Radar on the Windows desktop? 
You can place a shortcut to Radar on the desktop of Windows as follows: 

§ click on the Windows “START” button (in the bottom left corner of the screen) with 
the right mouse button, 

§ select “Open” from the pop-up menu (now with the left mouse button), 
§ double click on “Programs”, 
§ double click on “Radar 8”, 
§ click on the Radar icon with the right mouse button, 
§ select “Create shortcut” from the pop-up menu, 
§ with the left mouse button click the icon of the shortcut you have just created, hold 

down the mouse button, drag the icon to the desktop and release the mouse button : 
 

 
§  
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Q9. How do I automatically open the repertory when starting Radar ? 
Edit the properties of the Radar icon as follows: 

§ click on the Windows “START” button (in the bottom left corner of the screen) with 
the right mouse button, 

§ select “Open” from the pop-up menu (now with the left mouse button), 
§ double click on “Programs”, 
§ double click on “Radar 8”, 
§ click on the Radar icon with the right mouse button, 
§ select “Properties” from the pop-up menu, 
§ in the window “Properties for Radar 8”, select the “Shortcut” tab, 
§ at the end of the field “Target”, insert the code for the repertory you would like to 

open and click on “OK” to apply the changes and close the “Properties” window. 
 

Codes for the repertories : 
English Kent  KE11 
French Kent  KFE21 
German Kent  KG21 
English Synthesis 6.0  SE60 
English Synthesis 7.0  SE70 
English Synthesis 8.0  SE80 
German-English Synthesis 7.01 SGE701 
French-English Synthesis 5.05 SEF505 
Portuguese-English Synthesis 5.02 SEP502 
Spanish-English Synthesis 6.06 SSE606 

Q10.  Why do I get the message “you don’t have access to the 
document...”? 
In the target field of the Radar icon there is the code for a repertory that you did not 
purchase. During the installation of Radar you installed this repertory by error from 
the “Radar : Data x” CD-rom and chose to open it automatically when starting 
Radar. 
Check the repertories that you have ordered and remove the code for the repertory 
that you cannot access (refer to the above question for the procedure to edit the 
properties of the Radar icon). 

Q11.  How do I update from Radar for Windows V7 to Radar 8 ? 
When updating from Radar 7 to 8 you just need to install Radar 8 in the same 
folder where Radar 7 was installed on the hard disk (by default, C:\RADAR).  
Note: you should not reinstall the databases (Synthesis, Keynotes) unless you 
install a newer version of the Synthesis or Keynotes. If you overwrite the existing 
version of the Synthesis, your personal additions to the repertory may get lost! 
Read more about transferring additions from the Synthesis to a newer version here 
below. 

Q12.  How do I update from Radar for Windows V6 to Radar 8 ? 
When updating from Radar 6 to Radar 8, you must pay attention not to delete or 
overwrite your personal data (cases, patient files, repertory and keynotes additions, 
...). If you also install a new version of the Synthesis repertory, read also about 
transferring your additions to a new version of the Synthesis later in this document. 
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N.B. : to avoid any loss of data, it is strongly recommended to make a 
backup of your data before you install the new version of Radar. 
Please read about backing up your data later in this document. 

  
 1) Backup the following files : 

 \radar\cases\*.* 
 \radar\patient\*.* 
 \radar\log\*.* 
 \radar\data\keynotes\*.* 
 \radar\data\”synthesis directory” (depends on your version if the Synthesis) 

 
 2) Install the Radar 8 program in the same directory where Radar 6 was installed. 

The repertorizations that you saved as “Cases” remain untouched by the installation 
procedure. 
 

 3) If you have purchased the WinCHIP module for the management of your patient 
data, you have to update your Patient files from Radar 6 to WinCHIP : 

 a) click on the Rad2Chip icon in the Radar group ( ) to start the conversion 
process, 

 b) select the catalog of patients you want to transfer and select OK. 
This will export all the information on your patients into text files stored in the 
directory ‘\radar\winchip.out’. Once the exportation is done, the program will close 
automatically. 

 c) start Radar and open WinCHIP by pressing F9 or click on  in the toolbar to 
open WinCHIP. The program will display the message “Some Radar repertorisations 
have not been imported in Winchip. Do you want to delete them ?” Answer No. 

 d) select “Import from RADAR Windows Patient files” from the “Tools” menu. Answer 
“Yes” to the question “Import Radar Patient files” ? This will initiate the transfer 
process of all your patient information. 

 
Remark : if you worked with several catalogs of patients in Radar 6, you must 
repeat steps a) to d) for each catalog. 

Q13. How do I update from Radar V4 for DOS to Radar 8 ? 
It is not possible to upgrade from Radar 4 to Radar 8. Print the cases that you need 
from Radar 4 so that you can recreate them with Radar 8. 

Q14. How do I update from Radar V5 for DOS to Radar 8 ? 
 1) Backup the following files : 

 Cases  \ARCHIMED\CAS\*.* 
 Patients \ARCHIMED\PATIENT\*.* 
 Personal Repertory \ARCHIMED\PR\*.* 
 Clipboard files \ARCHIMED\TMP\CB*.* 
  \ARCHIMED\TMP\LINKS.DAT 
 Symptom Notes \ARCHIMED\NOTES\SYMPTOM*.* 
 General Notes \ARCHIMED\NOTES\GENERAL*.* 
  

 2) Run the program “Upgrade to Radar 8” ( ). 
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 3) Select the data you want to transfer : Cases, Patients, Personal Repertory by 
checking or unchecking the boxes.  

 The cases will be transferred in the default cases catalog of Radar 8 and will have 
the same name as in the Dos version of Radar.  

 The data of your Personal Repertory will be transferred in the Synthesis you use in 
Radar 8. 

 4) If you have purchased the WinCHIP module for the management of your patient 
data, you must update your Patient files to WinCHIP.  

 Please read about the procedure in the above question “How do I update from Radar 
for Windows V6 to Radar 8”. 

 5) Check that all your data is correctly transferred from Radar Dos to Radar for 
Windows. 

 6) Delete the old Radar for Dos environment. You need to delete the directories 
\ARCHIMED and \RADMOUSE. 

Q15. How do I backup my personal data ? 
Computers are always getting more reliable and maybe you wouldn’t think that your 
system might break down one day. But imagine that Windows suddenly crashes or 
there is a power break down while you are working with Radar. You are making 
additions in the Synthesis when the computer stops working and have no chance to 
save your work. Now the files of the Synthesis are in an unknown state, probably 
so badly damaged that you are not able to recover them. Or you were going to 
save a repertorization for a patient you had just created. Your patient file is now 
unusable because it was not properly closed.  
Or even worse, you installed a game for your kids and there was a computer virus 
on the floppy disks. The virus wiped out all the files on your hard disk ! 
In all those cases the situation is dramatic: you have lost your work, maybe hours 
of labor!! 

 
To avoid this kind of situation we strongly recommend you to make regular backup 
copies of your data. 

 
If you made additions or modifications in the Keynotes, backup the following files: 

  C:\RADAR\DATA\KEYNOTES\*.* 
If you made additions or modifications in the Synthesis, backup the following files: 

  C:\RADAR\LOG\*.* 
  C:\RADAR\DATA\SYNT_xx.xxx\*.* 
 
  where “xx.xxx” means the abreviation of the Synthesis: 

E.60  Synthesis 6.0 (English) 
GE.701 Synthesis 7.01 (German-English) 
ED.52 Synthesis Mind-Psyche 5.2 
EI.503 Synthesis 5.03 (English-Italian) 
E.70  Synthesis 7.0 (English)  
E.80  Synthesis 8.0 (English) 
EI.60 Synthesis 6.0 (English-Italian) 
ES.601 Synthesis 6.01 (English-Spanish) 
SE.606  Synthesis 6.06 (Spanish-English) 
EF.504 Synthesis 5.04 (English-French) 
EF.505 Synthesis 5.05 (English-French) 
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 If you made additions or modifications in the Remedies or Authors, backup the 
following files: 

  C:\RADAR\SYSTEM\Remed.* 
  C:\RADAR\SYSTEM\Rem_udef.lst 
  C:\RADAR\SYSTEM\Author.* 
  C:\RADAR\SYSTEM\Aut_udef.lst 
 

If you made additions or modifications in the Concepts, backup the following files: 
  C:\RADAR\LOG\*.* 
  C:\RADAR\DATA\CPTS_xx.xxx\*.* 

 where “xx.xxx” means the abreviation of the Repertory of Concepts 
linked to the Synthesis (see here above). 

  
If you saved repertorisations as Cases, backup the following files: 

  C:\RADAR\CASES\*.* 
 

If you saved Patients with the program “WinCHIP”, backup the following files: 
  C:\RADAR\WINCHIP\*.* 
   

If you saved Patients with Radar, backup the following files: 
  C:\RADAR\PATIENT\*.* 
  C:\RADAR\SYSTEM\DIAG*.* 
 

To help you to make a backup, we have made an icon in the Radar 8’ group called Radar 
Backup’, this icon will copy all the important files listed here above in the folder 
\radar\backup on your hard disk. 

  
 You just have to click this icon to make a hard disk ’backup’ and then copy the folder 

\radar\backup on a tape, diskettes, Zip-drive, CD-ROM or any other backup device.  

Q16.  Some information is not printed when I print the Analyze or the 
result of the Comparative Extraction. 
All printouts of Radar are printed in colors. A black and white printer normally 
converts colors into levels of gray but some printers cannot convert colors (for 
example some printers cannot print the 3rd degree remedies that are printed in 
magenta). The solution is to either select another color than magenta in the menu 
“Options, Fonts and colors” or to select “Black and white printer” under “Options, 
General Options”. 

Q17. I cannot find some words in the “Extended Search” function. 
When you type a word to search for, it doesn’t matter if you type it with small or 
capital letters. But this doesn’t apply to words that begin with accentuated letters (é, 
à, ù, ..). If you don’t find a word that begins with such a letter and you don’t find it 
when typing a capital letter, type a small letter.  

Q18. Why do I have to give a name to a Multimedia object? 
It is not yet important to name a multimedia object. But in a later version, it will be 
possible to make searches on the name of multimedia objects.  
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Q19. How can I transfer a case to a colleague? 
To transfer a case to a colleague, the case must have been saved on the hard disk.  
In the Clipboard window select “File”, “Export Case”. Type the name of the file to 
export and the location (path) where it should be placed. This text file can then be 
give to your colleague. 
To import this case, your colleague must proceed as follows: in the clipboard 
window select “File”, “Import case”, select the file you gave him and hit OK. If he 
wants to save this case on his own hard disk, he should select “File”, “Save to disk” 
and type the name of the case. 

Q20. Where do the Radar Keynotes come from? 
The information contained in these keynotes comes from the following documents: 

  
T.F. Allen - Encyclopedia of Pure Materia Medica. 
H. Bernard - Traité de Médecine Homeopathique. 
W. Boericke - Pocket Manuel of Homeopathic Materia Medica. 
C.M. Boger - A Synoptic Key of the Materia Medica. 
J.C. Burnett - Vaccinosis. 
J.C. Burnett - Fifthy Reasons for Being a Homeopath. 
J.H. Clarke - A Dictionary of Practical Materia Medica. 
A.C. Cowperthwaite - A Text-Book of Materia Medica and Therapeutics. 
Les Entretiens du Centre d'Etudes et de Documentation Homéopathiques. 
E.A. Farrington - Clinical Materia Medica. 
E.A. Farrington - Comparative Materia Medica. 
V. Ghegas - Seminar Notes. 
S. Hahneman - Materia Medica Pura. 
C. Hering - The Guiding Symptoms of our Materia Medica. 
O. Julian - Dictionary of Homeopathic Materia Medica. 
J.T. Kent - Lectures on Homeopathic Materia Medica - New Remedies. 
J.T. Kent - Clinical cases. 
A. von Lippe - Key Notes & Red line Symptoms of the Materia Medica. 
R. Morrison - Desktop Guide, keynotes and Confirmatory Symptoms. 
J. Mezger - Gesichtete Homöopatische Arzneimittellehre. 
S.R.Phatak - Materia Medica of Homeopathic Medicines. 
R. Sankaran - The Spirit of Homeopathy. 
R. Sankaran - The substance of Homeopathy. 
F. Schroyens - Synthesis 
F. Schroyens - 1001 Small Remedies. 
M. L. Tyler - Pointers to the Common Remedies. 
G. Vithoulkas - Materia Medica Viva. 
G. Vithoulkas - Stolen Essences. 
G. Vithoulkas - Esale Conference. 
A. Zaren - Information from seminars. 

Q21.  How can I have a list of the additions I have made in the 
Synthesis ? 

§ Close Radar, 

§ Open the program “Repertory Utilities” , 
§ Select the Repertory that contains your additions, for example let’s assume you 

made additions to the Synthesis 7 : 
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§ Select “List, Complete list of the log file” : 
  

  
  

§ Select the Log file and hit “OK” : 
  

  
  

§ Your additions are listed in the file \radar\log\”repertory_name”.TXT where 
”repertory_name” stands for the repertory containing your additions, for example 
“SE70.TXT”. 

Q22. How do I transfer my additions to a new version of Synthesis ? 
To transfer your own additions from Synthesis English 7.0 (SE70) to the new 
Synthesis 8.0 (SE80), we advise you to wait for the new Repertory Utilities 
program. 
 
When upgrading to a new version of the Repertory, for example from the english 
Synthesis 6 to version 7, the additions you made to the previous Synthesis version 
need to be transferred into the new Synthesis.  

  
Proceed as follows: 

§ Close Radar, 
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§ Open the program “Repertory Utilities” , 
§ Select the new repertory (target repertory) where the personal additions will be 

transferred: 
 

 
 

§ Select “Update, Update repertory from another LogFile” : 
 

 
 

§ Select the name of the Log File containing the additions to the previous Synthesis 
(source repertory). The log files are saved in the directory ‘\radar\log’. The name of 
this file is related to the previous name and release of the database: for example: 
“SE60.DAT” refers to the Log file of the English Synthesis 6.0, “SGE601.DAT” refers 
to the German-English Synthesis 6.01, etc. 

For example: 
 

 
 

§ When the additions from the previous release of the Synthesis have been transfered 
to the new one, the errors found during the transfer are listed in a report on the 
screen. This report can be printed. It is saved in the directory \RADAR\LOG. For 
example: SE70.LOG contains the list of errors and SE70.RPT contains the 
summary. 

 
Examples of “errors”: 

A rubric with a modification (spelling mistake) will be considered as a new rubric. Rubrics 
where new modalities were created: for example ‘amel’. was created as a new sub rubric. 
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In this case, ‘agg.’ will be created as another new rubric, and additions to the previous 
rubric (the one without modalities) will not be recognized. 

Q23.  How do I transfer my personal data from my office to my home 
computer? 
Let’s start that your computer in the office is called ‘OFFICE’ and the one at home 
is called ‘HOME’ 
1) To transfer the Cases: 

The cases are saved by default in the files \radar\cases\REPERT.DA1, DA2, 
ID1, ID2. You cannot just copy those files onto a diskette from computer 
‘OFFICE’ and then on computer ‘HOME’ otherwise you would overwrite all the 
cases on the home computer! You need to proceed as follows. 
 
On ‘OFFICE’ computer : 
§ Close Radar, 
§ Start the Windows Explorer, 
§ Open the folder \RADAR\CASES, 
§ Rename the following files  

from         to 
REPERT.DA1  OFFICE.DA1 
REPERT.DA2  OFFICE.DA2 
REPERT.ID1  OFFICE.ID1 
REPERT.ID2  OFFICE.ID2 

§ Copy the files OFFICE.* onto a diskette (Select files and then click on the 
right button of the mouse, choose 'send to' and then « 3 ½  Floppy (A:) ») 

 
On ‘HOME’ computer: 
§ Close Radar, 
§ Start the Windows Explorer, 
§ Open the folder \RADAR\CASES, 
§ Rename the following files  

from        to 
REPERT.DA1  HOME.DA1 
REPERT.DA2  HOME.DA2 
REPERT.ID1  HOME.ID1 
REPERT.ID2  HOME.ID2 

 
§ To copy the Cases files from the OFFICE, insert the diskette into the 

floppy drive, 
§ Start the Windows Explorer and open the drive A: 
§ Select the files OFFICE.* (« Edit », « Select all »), 
§ Choose « Edit », « Copy »,  
§ Open the folder \RADAR\CASES on the hard disk (C :), 
§ Choose « Edit », « Paste ». 

  
§ To use the Cases files from the OFFICE on the home computer, 
§ Start Radar, 
§ Open the Clipboard window 
§ Select the "File" and choose "Open another catalogue of cases"     
§ Select the file OFFICE.DA1 if you want to work with the cases from the 

office and select the file HOME. DA1 if you want to open the cases from 
home.  
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2) To transfer the patients files 

On ‘OFFICE’ computer : 
§ Start the Windows Explorer 
§ Open the folder \Radar\Winchip\Filepati,  
§ Rename the folder USER into OFFICE (if your patients are saved in 

another catalogue than the default ‘USER’, rename that other catalogue) 
§ Copy the folder OFFICE and its entire contents onto a diskette. 

 
On ‘HOME’ computer : 
§ Start the Windows Explorer 
§ Open the folder \Radar\Winchip\Filepati,  
§ Rename the folder USER to HOME, 
§ Insert the above diskette into the floppy drive. Copy the folder OFFICE 

from the diskette into the folder \Radar\Winchip\Filepati on the hard disk. 
 
To Select patients files to use on your home computer: 
§ Start WinCHIP, 
§ Choose "Open patient catalogue" from the "File" menu. 
§ Select the catalogue of patients file to open: 

 

 
3) To transfer keynotes 

On ‘OFFICE’ computer : 
§ Start the Windows Explorer, 
§ Select all the files in the folder \Radar\Data\Keynotes (Menu « Edit », 

« Select all », 
§ Click on the right mouse button, 
§ Choose "Send to", « 3 ½  Floppy (A:) » 
 
On ‘HOME’ computer : 
§ To copy the Keynotes files from the OFFICE, insert the diskette into the 

floppy drive, 
§ start the Windows Explorer and open the drive A: 
§ Select all the keynotes files from the diskette (« Edit », « Select all »), 
§ Choose « Edit », « Copy »,  
§ Open the folder \RADAR\DATA\KEYNOTES on the hard disk (C :), 
§ Choose « Edit », « Paste ». 

 
IMPORTANT: 
This overwrite the Keynotes files on the home computer ! 
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4) To transfer Authors/Remedies 
 NOTE 
 Transfer must be done only in one way. 
 

On ‘OFFICE’ computer : 
§ Start the Windows Explorer, 
§ Open the folder \RADAR\SYSTEM, 
§ Copy the files REMED.DAT & REMED.IDX and AUTHOR.DAT & 

AUTHOR.IDX onto a diskette. 
 
On ‘HOME’ computer : 
§ Start the Windows Explorer, 
§ Open the folder \RADAR\SYSTEM, 
§ Insert the above diskette into the drive, 
§ Copy the files from the diskette into the folder \RADAR\SYSTEM. 

 

Q24. How do I install the Radar databases on another partition? 
§ During the installation: 

Choose the ‘CUSTOM’ installation when you install Radar and its databases, 
you can then choose where the databases will be located. The path where 
Radar can find the databases is automatically updated. 

 
§ After the first installation:  

If you decide to move databases on another drive, you have to redefine the 
path.  

§ Start the program "Repertory utilities" (Radar must not be running), 
§ Choose the "File" menu, 
§ Select the option "Localization…" 

 

 
 

§ Double click the database. Click on "Browse" and specify the path. 
§ Exit  "Repertory utilities" and start Radar. 
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Q25. Can I open the Radar databases from the CD-Rom? 
No, the Radar databases (Repertories, Keynotes) must be installed on the hard 
disk of your computer.  

Q26.  Should I install the multimedia files on the hard disk or leave them 
on the CD-Rom? 
It depends on the capacity of your hard disk because files for multimedia take up to 
320 MB. If you choose not to install them, you have to insert the CD-Rom 
« Program + Multimedia » in the drive each time you want to work with Radar.  

Q27. How do I change the language of the symptoms? 
You can change the language of the symptoms when you use a bilingual repertory.  

Just click on the icon . 

Q28. How can I copy parts of the repertory into my word processor? 
 Proceed as follows: 

§ Select the symptom you would like to copy, 
§ Press CTRL C (or select « Copy » in the « Edit » menu) to copy the symptom 

into the Windows clipboard, 
§ Start your word processor, 
§ Choose "File", open an existing document or create a new one, 
§ Press CTRL V (or select « Paste » in the « Edit » menu) to insert the text of 

the symptom (only the text of the symptom is copied, not the remedies). 

Q29. How can I export a repertorisation to my word processor? 
§ From the Clipboard window of Radar: 

Select "Export" from the "File" menu,  
Type the name of a file (8 characters max) with the extension ‘TXT’ 
To open in the word processor: 
§ Start the Word processor 
§ Select "Open" from the "File" menu, 
§ In the "Files of type" box, select the type TXT or "All files", 
§ Specify the path where the file is located and open it. 
 

§ From the Analysis windows:  
Select "Export" from the "File" menu,  
Type the name of a file (8 characters max) with the extension ‘RTF’  
To open the file in the word processor: 
§ Start the program Word processor 
§ Select "File" menu 
§ Choose "Open" 
§ In the "Files of type" box, select the type RTF or "All files" 
§ Specify the path where the file is located and open it. 
§ This will display the complete table of the analysis 

Q30. How do I insert a new remedy or a new author in the Synthesis?  
To insert a new remedy that does not yet exist in the catalogue of remedies: 
§ Start Radar, open the Repertory 
§ Select the "View" menu 
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§ Choose the option "Remedy catalogue" 
§ Choose for example the remedy RMD01  
§ Click on the button "Edit" and type the abbreviation of the name you want to 

use 
§ Click on "Save" 

You can use the remedies RMD01 to RMD99 to define new remedies.  
 

To insert a new author that does not yet exist in the catalogue of authors: 
§ Start Radar, open the repertory 
§ Select the "View" Menu 
§ Choose the option "Author catalogue" 
§ Choose for example the remedy AUT01 
§ Click on the button "Edit" and type the abbreviation of the name you want to 

use 
§ Click on "Save" 
§ You can use the authors AUT01 to AUT99 to define new authors.  

 
Do not forget to backup the following files: 

C:\Radar\System\Remed.* 
C:\Radar\System\Rem_udef.lst 
 
C:\Radar\System\Author.* 
C:\Radar\System\Aut_udef.lst 

Q31.  How do I change the text editor of WinCHIP to my word 
processor? 
In WinCHIP 2.8, proceed as follows: 
§ Click on the "Options" Menu 
§ Select "Environment" 
§ Click on the thumbnail "Text editor" 

 
§ Click on the box "Use external text editor…" to set the check mark 
§ Specify the path to the text editor.  
 

Q32. How can I open the Radar Keynotes V3 by default? 
Edit the file Radar.INI that is located in \Radar\Bin 
 
Proceed as follows: 
§ Open the Windows Explorer 
§ Double click on the file Radar\Bin\Radar.INI to open it  
§ Look for the keynotes section 
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§ Add after Keynotes = 15, … (and leave the other parameters unchanged) 

 
 
Here after, the list of available keynotes and their number: 

 
01 Radar Keynotes (English) 
02 Boericke (English) 
03 Personal Keynotes 
04 Boericke (Deutsch) 
05 Boericke (Dutch) 
06 Hering, Kurzgefaßte Arzneimittellehre 
07 Radar Keynotes (Português) 
08 Allen Keynotes (English) 
09 Radar Keynotes (Spanish) 
10 Boericke (Português) 
15 Radar Keynotes (V3) 

 
For example, if you want to open the Radar Keynotes V3 and then Hering Keynotes 
by default you would edit RADAR.INI as follows: 
 
[Keynotes section] 
Keynotes=15,6 
 

Q33. Where can I find the description of the new features in Radar? 
You can find the description of the new features in a file on the "Program and 
multimedia" CD-Rom 
 
Proceed as follows to open the file: 
§ Insert the CD-Rom ‘Program & Multimedia’ into the CD-Rom drive, 
§ Open the Windows Explorer, 
§ Select the CD-Rom drive, and open the folder \Radar\Bin, 
§ There is a file for each language. Select the file according to your language. 

Each file is named NEWS… (followed by the three first letters of the language). 
§ Double click for example on NEWSENG.PDF 
§ ACROBAT READER is automatically loaded. You can view the document or 

print it (Select the "File" menu, choose "Print" or press CTRL P) 

Q34.  How can I repair a damaged repertory? 
§ Close RADAR  
§ Open the Windows explorer 
§ Select the repertory RADAR\DATA\xxx (where xxx is the abbreviation of the 

repertory, for example, SYNT_E.70) 
§ Select the files SYMPTOM.IDX and EXTRACT.IDX  and delete them. 

§ Run the "Repertory Utilities" program ( ), select the repertory to repair and 
click OK. 

§ Select the "Repair" menu,  choose "Symptoms" 
§ Select again the "Repair" menu,  choose "Extractions". 

KeynotesDrop=1    
1 : open automatically the first keynote 

following preferences 
2 : the user have to choose which  document 

he wants to open  
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If the problem is not solved, you can use the same procedure and choose "All 
tables" from the "Repair" menu. 

Q35.  How can I repair a damaged catalogue of cases? 
§ Start the Windows Explorer and delete the following files: 

  C:\RADAR\CASES\REPERT.ID1 
  C:\RADAR\CASES\REPERT.ID2 
 

§ Run the "Repertory Utilities" program (
 

), select the Synthesis repertory 
and click OK. 

 
§ In the "Repair databases" menu, select "Cases " : 

 
§ When the message "Table ... successfully rebuild" appears, click OK and quit 

the program. 
§ Restart Radar. 
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Q36.  How do the Repertory views change ? 
The way in which the views change automatically is the following: 
 
Once you change the view it remains changed from then onwards, which is logical 
and the most easy procedure: in this way you see the remedies of the analysis in 
your rubrics and vice versa. 
 
One exception has been programmed: when you enter the VES for the first time, 
the program changes to Vithoulkas view. This is to accommodate the VES users 
who more likely want to use the Vithoulkas view.  
 
If nevertheless someone wants to use the VES with for example the Full Synthesis, 
he has to select this view only once while in the VES and the program will then 
remember when he enters the VES the next time. 
 

 


